
CC BASICS Tutorial
CC 2022 

v 22.4

“Film editing is why people like movies.  Because in the end, wouldn’t we all want 

to edit our own lives?  I think everybody would like to take out the bad parts, 

take out the slow parts, and look deeper into the good parts.” 

- Bob Cohen, director

 Premiere 
An introduction to video editing 

Premiere Basics Video Tutorial 
(for those who like videos) 

the video was made using an older version of Premiere so you’ll see some differences.

https://www.youtube.com/watch?v=6GWW_plX12c&feature=youtu.be
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Adobe Premiere is a non-linear video editor. 

You can edit your video in any order you want, and access the beginning, middle 
and end of your video simply and quickly.

It is also non-destructive. This means you can cut, delete, move, change, and adjust 
your audio and video happy in the knowledge you haven’t destroyed anything.

This tutorial is designed as a get-started tutorial NOT a  complete Everything 
You Always Wanted To Know About Premiere And Were Afraid To Ask tutorial.
It is updated for Adobe Premiere CC 2022

GET READY
Preparing yourself and Premiere

Before you open the program it is extremely important to get organized.  Video 
editing is complicated. There are many files and folders and it is very easy to ‘lose’ 
stuff.

Get Organized. Stay Organized.
you will thank me later.

*Create a Project Folder for every, er, project.*

This folder will hold everything associated with your project. Here is a sample 
system - the exact naming convention is less important than being consistent and 
logical: 

•
Many of the terms we use in 
video editing come from the 
days of film and razor blades 
and linear, ‘do it by hand’ 
editing.

•

•
There are two kinds of 
people. Those with messy 
sock drawers and those who 
organize their socks. 
Multimedia requires you to 
organize your socks or pay 
the price later.

•
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FOLDER NAME:  It should include your name and a one-word description of 
your story. I use the year at the front to make it easy to find and sort.

_AUDIO: Any audio captured separately from video. This could include interviews, 
nat sound, sound effects, music, etc.

_GRAPHICS: Any graphics that will be used in your project. This could include 
title slides or elements created in programs such as After Effects or Photoshop. 

_OUTPUT: Where you will put your finished movie

_STILLS: Any still photos that are part of your project - they could be yours or 
archival images from other sources

_VIDEO:  All your video content

NOTE the two files at the bottom. These are created by Premiere when you first 
save your project. MAKE SURE to save them to your project folder.
 .prproj is your Premiere project file. 
 Auto-Save has backups of your project in case Premiere crashes. YOu can set  
 the interval for auto saving in Premiere Preferences. By default, Premiere will  
 save your project every20 minutes.

DO THIS And your project will exist in a single place. You can copy it to another 
drive, give it to another person to edit.
DON’T DO THIS and files will get lost.  Projects won’t work and your harddrive 
will fill up and you will go crazy.

TIP
•

For bigger projects make 
subfolders. Break your video 
up by day shot and/or content 
by making subfolders in the 
_VIDEO folder

•

TIP
•

I strongly recommend using a 
fast external harddrive 
to store your work. Solid state 
drives by Samsung among 
others are very reliable and 
durable.

•
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Project Workflow

1. Create a project folder and subfolders for ALL your assets.
2. Copy your video and other assets into your project folder (eject and put away 
your SD cards, etc.)
3. Launch Adobe Premiere and set up your project. Save the project file to the same 
folder
4. Organize assets in Premiere
5. Edit your assignment.
6. Tweak the audio.
7. Correct color.
8. Add any effects, titles, lower thirds etc.
9. Share (export your video).

PREPARING PREMIERE
Open Adobe Premiere

• New Project – select if you’re starting a new project
•. Open Project –  select to continue working on a project
• Recent Projects – select from the list of most recent projects
• Learn – access to tutorials on using Premiere (the gift box icon)

TIP
•

Copy your assets(video, stills, 
audio) off your camera’s card. 
Eject the card and put it away 

before doing anything else.

Don’t leave your card behind.
•
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Select New Project 

If you are starting a new project, click the New Project Button and you will get this 
window.

1. Project Name:  Name your project. Include the year, your name, and the project 
name.  20220613_YourName_ProjectName

2. Project Location: Select your project folder(which you already created). This way 
the Premiere project and all your video will be togther.

3. Optionally, you can select your footage from this window. Browse to the video folder, 
and select the video files you want to edit. You can also do this step later.

4. Import Settings:  You can choose to create a bin(Premiere’s word for a folder) 
in your project, and have Premiere create a sequence of all your video. 

Click Create

TIP
•

REMEMBER. Create a single 
folder for each project and 
save EVERYTHING to that 
folder. Put all your original 
content in that folder along 
with all your Premiere files 
and folders.

•

•
And back it up!!
Every hard drive fails. It’s just a 
question of when.
Save projects in at least two 
places.
Get a second hard drive, 
use an online cloud storage 
service, do something to save 
your work.

•
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IF you didn’t select any clips, you’ll get a blank editing window and will need to im-
port your media.

Option A: you didn’t select any clips             Option B: You selected your video clips

From here, you’ll import your assets - video, stills, audio etc. 

Then, you’ll create a sequence or timeline and begin to edit.

A VERY important early step is to make sure that your sequence is set to 
match your video. You don’t want your HD video squished, or if you’ve moved to 4K 
have it not fit in a HD window.

As you’ll see, you can manually set the properties of a new sequence.

OR, you can simply drag a piece of video onto the timeline and it will be created for 
you.

If you choose this method, MAKE SURE, you tell Premiere to change the sequence 
settings to match the video if asked.

If you selected clips to import, and told Premiere to create a sequence, you can 
begin editing. You can also add content at any point.

Watch a 3:15 video on starting a project in Premiere

TIP
•

You could go through the steps 
to set your Sequence settings 
to match your video.

BUT it is much easier to do 
this automatically when we 
start editing.

*NOTE*

If you are shooting only stills, 
not video, you MUST select 
the proper Sequence Preset 
manually.  For audio slideshows 
generally you can select the 
DSLR 1080p30 setting

•

https://vimeo.com/720373667


Editing With Adobe Premiere Pro

Tips & Tricks

updated June 2022

8

PREMIERE OVERVIEW
Below, an example of what a video project looks like.

Note how Premiere is organized into four panes plus tool bars. This is a pretty 
standard video editing environment.

SOURCE: This is where you will look at all your ‘stuff ’ - video, stills, etc. and decide 
what you want to use in your story.

PROGRAM: This is where you see your story as you build it on the timeline 
below. The Program window shows you what is on your timeline, and will play back 
your video.

SEQUENCE: This is your story. It is also called the Timeline. This is where you will 
edit and create your project. You can create multiple sequences to work on different 
parts of your project, or create versions of a single project.

PROJECT: This is where you can see all your content – video, stills, audio, etc. 
Premiere does not actually store your material – it simply points to wherever your 
material is stored. That is why you need to stay organized and not move material 
around or leave it on the wrong computer where Premiere can’t find it.

TOOLS:  The various tools you’ll use when editing on the timeline.

•
BEFORE you import 

your content, consider 
renaming and 

organizing your files. If you 
create folders, Premiere can 
import your content in those 

folders.

For example, you could put 
your interviews in one folder, 
your b-roll in another, your 

tight details in a third. Or, you 
could create separate folders 

for separate interviews. 

Spending the time to 
organize your clips and other 
content in advance can save 
you a LOT of time once you 

begin editing.

A program like Photo 
Mechanic or Lightroom 

will let you look at all your 
material and rename in 

batches. A big time saver.
•
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IMPORTING CONTENT

You can import your content when you first start a project. But you can add content 
at anytime as well.

There are multiple ways to bring your assets into Premiere. 

You can click File>Import (⌘-I).  
You can right-click or double click in the Project window
You can switch to the import window using the tabs at the top left.

MEDIA TYPES

 There are many types of files that you can import into Premiere.

Audio files may be .mp3, aif, wav
Still images could be jpeg, tif, psd among others
Video files can be .mov, mp4, flv, AVCHD among many others

Watch a 3:20 video on importing content into Premiere

•
For older video cameras you 
may need to use the Media 

Browser. 

For cameras that have a 
complicated file structure, the 
Canon Vixias, Panasonics, etc., 
the best way to import is to 
use the Media Browser in the 

Project Pane

Select the Media Browser Tab
• Navigate to your media: 
It can be displayed as either 
thumbnails or in list view
• Media Browser should 
automatically detect the types 
of files

• Select the clip(s) you want 
to use
• Control Click (right click) 
and select Import

•

https://vimeo.com/187431977/719e54538d
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•
Learn to use the keyboard 
shortcuts and you will save 

time. 

Among the most import, 
-S (command S) to save 

your project.

Premiere does autosave on a 
regular basis. but saving your 
work as you go will save you 
time when(not if) Premiere 
crashes while you’re editing. 

•

•
Another GREAT shortcut 
is the tilde key ~.  The key 
makes whatever pane you’re 
working in full screen. Want 
a close up of your Media 
Browser or timeline?  The ~ 
key is the answer.

•

EDITING BASICS

1.  Use the Project Pane and Source window to look at your content
2.  Select which clips or parts of clips you want to use
3.  Place clips on the timeline (sequence)
4.  Cut, move, edit, arrange clips on the timeline

Editing starts with deciding what to include and what not to use in your project.

You shot a lot of video, maybe took a lot of photos – but you won’t use everything.
You can look at all your material in either the Project Pane or in the Source Pane. 

After looking through a clip you will make a decision:
1. You don’t want anything from the clip.  That’s easy, just ignore it
2. You want all of the clip on your timeline
3. You want part of the clip (or parts)

Getting an entire clip (or still image) onto the timeline can be done in several ways.

1. You can drag it directly to the timeline from either the Project or Source Panes, place 
it wherever you like and release.

2. Use the Insert or Overwrite buttons to place the clip on the timeline. This only 
works with a clip in the Source Pane.

The first button is the Insert button. This will put the clip on the timeline, starting 
at wherever you have placed the playhead on the timeline and push all other content 
forward, out of the way.
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The second button is the Overwrite button. This will put the clip on the timeline 
starting at the playhead, but overwrite(erase) whatever is underneath it. 

PLEASE PLEASE read the tip on this page. It is VITAL that the first clip you place 
on your timeline be video NOT a still photo or audio (unless you are editing a slide-
show with no video of course)•

The FIRST clip you place on 
the timeline MUST be video. 

Because we are using this clip 
to set the timeline to match 
your video format.

You will get this box:

You DEFINITELY DEFINITELY 
DEFINITELY want to select 
“Change Sequence Settings”

This will set the sequence to 
the proper settings for your 
video. If you drag audio or stills 

first, your timeline will be wrong.

•
Watch a 1:44 video on 

‘Changing Sequence Settings’

Watch a 1:40 video on using the insert and overwrite buttons

For this example I made the video 
on the timeline orange to make the 
change more noticeable.

The middle image shows the insert 
button in action. The existing video is 
pushed forward to make room for the 
new (blue) clip.

The bottom image shows the over-
write button at work. The new (blue) 
clip covers up existing content and 
replaces it. 

The video below should help make 
sense of this.

https://vimeo.com/187436108
https://vimeo.com/187436108
https://vimeo.com/187456611
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Using part of a clip.  Often, we only want part of a particular clip – 
a key quote or moment.

IN and OUT points

Select part of a clip using IN and OUT points. In the Source window, as you play the 
video, use the ‘I’ and ‘O’ keys to establish the start (In) and end (Out) of the video you 
actually want to use.

The lighter grey bar shows the selection made using the In and Out points. It is a 
subset of the full clip. You can use the buttons to set In and Out, or the I and O keys 
on the keyboard.

Change either point by playing the video and reselecting I or O.

IMPORTANT
Premiere is non-destructive. Even though you select part of a clip, it is easy to use 
more or less of that clip once it is on the timeline. 
So don’t worry about making this edit perfectly precise. It is easy to change later.

•
More SHORTCUTS

Space Bar - will stop 
and start a video in either 
the Source pane or on the 
Timeline

OR

Use the J,K,L keys to 
control the play of video.
J - play in reverse
K - stop
L - play forward

BONUS POINTS
Hit the J or L keys multiple 
times to speed up the video 
playback

•

Watch a 2:19 video on setting an in and out point

https://vimeo.com/187457597
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•
More J,K,L goodness::

Hold the K key, then tap the 
J or L keys to advance or 
retreat one frame at a time.

OR

Press the K and L keys at 
the same time to play in slow 
motion

•

Tools
Tools are nested inside each other. The small arrow next to a tool 
indicates you can click to access other similar tools.

Another good reason to learn the quick key shortcuts and save on 
mouse clicks.

Note the small arrows next to most of the tools. 
Click on the arrow to reveal other similar tools.

All the tools, their uses, and shortcut keys
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Basic Editing
• Trimming
• Cutting
• Moving

Trimming is shortening (or lengthening) a clip from either end.
 Use the Select Tool (V). Place it at the edge of a clip. Click and drag to shorten or  
 lengthen the clip.

Cutting is dividing a clip into two or more pieces
 Use the Blade Tool (C) to cut a clip. Place the playhead at the location you want to  
 cut and click the blade tool. Alternatively, you can stay with the Select Tool and use  
 ⌘ K to cut.

Moving is, obviously, moving a clip to a new position on the timeline
 Use the Select Tool (V). Click and drag a clip. You can drag it up and down to a  
 new track. Be careful not to place it on top of an existing clip. This would delete  
 the existing clip.

Use the standard Select Tool(V) to lengthen or 
shorten a clip from either end.  With this tool, 
shortening a clip will leave a gap, lengthening a clip 
over another clip will overwrite that second clip.  
NOTE: If you reach the end of your clip, you obviously 
won’t be able to make it any longer.

The cursor turns to a red arrow symbol when using 
the standard Select Tool(V) to trim.

Name your clips on the 
timeline

Want to organize a lot of 
clips on the timeline?

Can’t remember which is 
which?

Have an interview broken 
up into a a dozen pieces?

Control click on a clip on 
the timeline and select ‘Re-
name Clips.’ 

Use keywords or phrases to 
stay organized.
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The Ripple Edit Tool(B) lets you shorten a clip and at the 
same time remove the gap that would be created – two 
steps in one.
NOTE: The Ripple Tool changes the duration of your 
video.
The cursor turns to a yellow arrow symbol for the Ripple 
Edit Tool(B). 

The Rolling Edit Tool(N) is used to change the edit point 
between two clips. If one clip, for example, were too long, 
and the next clip too short or you’re concerned about 
where the edit is for timing or other reasons, you can 
easily move that edit point to better balance the length of 
the clips.
NOTE: the Rolling Edit Tool(N) does NOT change the 
duration of your video, It simply moves an edit point.    
This cursor is for the Rolling Edit Tool(N).

•
It’s worth learning as many 
keyboard shortcuts as you 
can to speed up the editing 
process.

Fast editing means more time 
for other things like shooting 
(or sleeping)

•

•
Another cool shortcut – for 
the Rolling Edit Tool.(N) and 
the Ripple Edit Tool(B). If 
you know exactly where you 
want to move your edit point 
to, put the playhead at the 
new point, and press ‘E’. Your 
edit point will move to that 
point. Cool. 

Especially useful for audio 
slideshows and still images.

•

The Track Select Tool(A or Shift+A) allows you to select 
all the tracks ahead of or behind the cursor. This is useful 
if you want to move multiple clips at the same time. By 
default, the tool selects all clips on all tracks ahead ofthe 
cursor. 
Shift +A at the same time reverses the direction
Hold down the Shift key to select all the clips on just one 
track.

A Little Beyond the Basics
Other tools can make editing quicker. What might take several clicks with 
the basic tools can be done with a single click or keystroke if you learn 
to use the proper tools.
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To begin editing, start with the basics  
(Imagine Julie Andrews singing Do Re Mi)

Use The Select tool(V) to move clips around and shorten and lengthen them from the 
ends.

Use the Blade tool(C) to cut clips, breaking them into parts or cut out a section in the 
middle - get rid of that annoying ‘um’ or longer sections that distract or go off point.

Those two tools (remember the keyboard shortcuts – V for the select tool and C for the 
blade tool) will let you do most of your basic editing.

In writing, words sentences and paragraphs are your building blocks.

In video it is clips and sequences and edits.

The clips are your basic content - if you didn’t shoot good material, or enough material, 
you will struggle, and do better next time.

Sequences are a series of clips that connect together the way words form sentences 
which form paragraphs – It forms the narrative of the story.

You need to avoid the basics mistakes such as jump cuts, but you also need to create 
something that makes sense narratively.

And finally, the edit establishes the rhythm of your piece – think about the sound, and 
the narrative. Cuts between shots should feel natural and be invisible to your viewer. 
The transition between shots and between scenes establishes a rhythm and feel for your 
video.

Watch this 8:36 video on using the edit tools

Cool shortcut
⌘ - K will cut a clip at the 
playhead. Saves you having 
to switch to the blade tool! 
Those seconds of time add 
up!

•
The best way to learn is by 
doing. Shoot, edit, and then go 
shoot again. 

There are also nearly limitless 
tutorials online. YouTube is a 
great and free resource.

And some great books on the 
subject of filmmaking.

One of my favorites is 
“In The Blink Of An Eye”
by the amazing film editor 
Walter Murch

https://vimeo.com/manage/videos/187458543
https://www.powells.com/book/in-the-blink-of-an-eye-a-perspective-on-film-2nd-edition-9781879505629


Editing With Adobe Premiere Pro

Tips & Tricks

updated June 2022

17

Audio
Your audio may be part of a video clip or recorded separately. In either case you can 
edit and adjust your audio in Premiere.

By default, Premiere imports stereo audio on one track.  IF you set your preferences to 
the tip at left, your audio should be on two tracks - this allows you to edit each track 
separately. 

Useful if you have recorded with two different mics, or at different levels. 

IF your stereo audio is on one track and you need to split it, control click on the file in 
the Project Window and  select Modify>Audio Channels. (fig. 1)
Change the ‘Preset’ from ‘Use File’ to ‘Mono (fig. 2)

fig. 1

fig. 2

•
SETTINGS:. 

I prefer that my stereo 
audio be on two tracks so 
each track cand be editing 
separately.  To do so, set your 
prefereces like this:

Preferences > Timeline > 

Default Audio Tracks > Stereo 

Media: Use Mono.

If you need to edit the tracks 
separately you will then unlink 
them from each other.

•

•
File Types

If you’re not sure what kind of 
file you’re working with, video 
or audio, control or right click 
on the file in the Project Win-
dow and select ‘properties...’

•



Editing With Adobe Premiere Pro

Tips & Tricks

updated June 2022

18

Adjusting Audio on the Timeline

Generally, you want to see the wave form - the visual representation of the audio. It will 
make editing easier - you can see the pauses, and breaks in words which are logical edit 
points.

If you can’t see the waveform of the audio, increase the height of the track.
Note how the select tool changes shape and allows you grab the edge of the track
and pull down.
You can also turn off the volume, ‘mute’ a track by clicking ‘M’ or play only that track by 
clicking ‘S’ for solo.

The white line should become visible when the track is deep enough.  IF you don’t see 
that white line, click on the wrench icon and select’ Show Audio Keyframes’

Click and drag the white line up and down to adjust the volume of the audio.

Your goal is to have your audio adjusted so it is consistent throughout your video.  You 
don’t want listeners screaming in pain as they rip off headphones because of blaring 
sounds, nor do you want them missing critical sounds because everything suddenly 
became too quiet.

For the web, we aim for our audio to peak between -3 – -6dB.  Use the audio meter in 
Premiere to monitor your clips. Click and drag the white line on the waveform to raise 
or lower the volume.  (The levels will be different from broadcast televistion)

OR

There are other ways to adjust your audio levels. Using the white line limits you to 

•
Adjust your audio volume 
by watching the audio 
meters NOT just by 
listening through your 
headphones. 

You can turn up and down 
your headphones. You want 
a more consistent measure 
of good audio levels.

The waveform will bounce 
as your audio plays. You 
want your typical sounds to 
hover around -3 – -6dB.
DON’T let your audio hit 0 
or it will become distorted.
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increasing your audio by 15dB. For more control,  control-click on the audio file and 
select ‘Audio Gain’ from the menu.  You can adjust your audio by a specific decibel 
amount or let Premiere adjust the clip to a preset level of your choosing. 

Balancing Audio
IF your audio is only in one channel. (you only hear it in one speaker, and only see audio 
in the meter on one channel):

Right click (or Control Click) on the clip in the timeline

Go to Modify>Audio Channels

IF, for example, you only had audio on the left channel, you would change both Source 
Channels to the ‘left’. Then your sound should come out both speakers.
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“Fixing Audio”

NOTE THE QUOTE MARKS.  There are real limits to what you can fix in bad audio.

It is very difficult to remove sounds such as background noise or hiss.  And if your 
audio was recorded in a stairwell or outside on a windy day, you’re probably stuck.

Premiere has some filters/effects that can be used.  And you have the option of 
importing audio in Adobe Audition and applying more extensive filters. 

Volume
If your audio is too soft, you can raise the volume.  Often, that will create more hiss in 
your audio.

If your audio is too loud - so loud it is distorted, there is little you can do to fix the 
problem.  Lowering the volume won’t eliminate the distortion. (Though it’s still worth 
doing to save the ears of your audience)

Noise

Hiss and other steady background noise can sometimes be filtered. Though it may 
degrade the overall audio quality of the clip. Audio quality can be adjusted in many    
ways that are way way way beyond the scope of this tutorial.
A good tutorial on using Audition to fix stuff here

Premiere has some built in tools as well.

In Premiere,  select the clip and then go to the Essential Sound Panel
Window>Essential Sound

Select the type of audio - dialogue, music, etc. 
From there you can select to adjust or repair or modify the audio.

You can try to remove hiss or other noises, reduce the echo, tonal quality.

It is ALWAYS best to start with good audio. Garbage in/Garbage out is absolutely true 
when it comes to audio quality.

Deleted your audio??
IF, you put a clip on the 
timeline and delete the audio 
because you only wanted the 
video, you might find a time 
you change your mind.

How to reconnect the audio 
is not obvious.

Here is a quick shortcut/trick.

Put the playhead over the clip  
and press X. 
This should mark the clip.

Click F for match frame. This 
will match the clip on the 
timeline with the same clip in  
the Source Window.

Click . (period) to overwrite 
the clip with the same clip 
plus audio!!

This is WAY easier than any 
other method. 

https://www.youtube.com/watch?v=n4FHoi1cs_s&t=8s
https://www.youtube.com/watch?v=HyTKdw_1WZE
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After opening the Sound Panel you can first select the type of sound:
Dialogue, Music, effects or ambience.

Premiere then offers a host of adjustments, using simple sliders specific to the type of 
sound selected. 

Under Repair, you can try and remove hiss, rumble, hum etc.
Other tabs offer adjustment to sound quality and tone.

For more extensive audio control,  control-click on the file and select Edit Clip in 
Adobe Audition. (Assuming you have Audition installed). This will open the file in 
Audition where you can apply more extensive ‘fixes’.
See this handout for a start on using Audition

Essential Sound Panel

•

Some good Premiere tutorials 
I’ve found for fixing audio 
glitches:

Fixing thin audio from a phone 
or cheap mic

Remove background sounds 
like a fan or hiss

Another tutorial on getting rid 
of background noise

Getting rid of (a little bit of) 
wind noise

https://www.willyurman.com/teaching/handouts/Audition_CC_2014_Tutorial.pdf
https://www.youtube.com/watch?v=setayq2RHzA
https://www.youtube.com/watch?v=setayq2RHzA
https://www.youtube.com/watch?v=25ZFA1xfMfU
https://www.youtube.com/watch?v=25ZFA1xfMfU
https://www.youtube.com/watch?v=DuEuLjH01I4
https://www.youtube.com/watch?v=DuEuLjH01I4
https://www.youtube.com/watch?v=HyTKdw_1WZE
https://www.youtube.com/watch?v=HyTKdw_1WZE
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Adjusting Audio

Fading Audio 

You may want to fade audio - to begin or end a clip for example. Or perhaps you’ll 
have natural sound that you want to have linger underneath an interview.

There are multiple techniques available.

1. Place the Selection Tool over the beginning or trailing edge of an audio clip until the 
arrow turns to a red line. Control-Click(Mac) and select “Apply Default Transition”

This will apply a fade in at the beginning of a clip, a fade out at the end and if you 
select between two clips, it will create a cross-fade.

2. Use the Pen Tool(P) to create a custom fade pattern.  Select the Pen Tool and click 
on the white audio volume line to create key points (called keyframes). You can then 
click and drag these to create a fades.

•
You can change the length of 
the default transition. 

Simply grab the end and 
lengthen or shorten it as 
needed.

•

If you apply the default 
transition to a clip, it will 
apply it to both the audio and 
video.

Click on the video transition 
and delete it, unless you also 
want your video to fade in or 
out.

•
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Reconnecting Media

Remember that an Adobe Premiere project doesn’t actually contain all your video/audio/
image files. The project simply points to those files.

IF those files get moved or renamed, and Premiere can’t find them, you will need to 
‘reconnect’ the media to the project.

Note the various warnings:  ‘Media Offline’ in bright red and the question marks next to 
each file in the Project Panel.  Bad news.

Assuming the files still exist somewhere and were not deleted, it is relatively easy to 
reconnect them. 

Typically, when you open a project, if media is ‘offline’ or ‘disconnected’ you’ll get a dialogue 
box asking you to find the missing media.

If you get this warning while working, or skip that message, you can open the reconnect 
box by right click (control click) on any of the files in the Project folder and select ‘link 
media’.  You will get a dialogue box asking you to find the ‘missing media’.

•
Another shameless plug for 
being organized.  IF you set 
up your project folder prop-
erly, and made sure to place 
all your assets – video, audio, 
graphics, stills, whatever – in 
your folder,...well...

...then I don’t get to tell you 
“I told you so.”

This problem most commonly 
happens when we have sloppy 
work habits and leave files on 
the desktop, or on our SD 
cards. 

Stay organized. 
•
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At the top of the box is the name of the missing clip and its original file name. (In this 
case they are the same)

Offline:  Tells Premiere to stop bothering you about this missing file.
Offline All: Tells Premiere to stop bothering you about all missing files.

Click ‘Locate’

By clicking the ‘Display Only Exact Name Matches’ only files with that exact name (or 
folders) would be displayed. Makes finding a file easier.

Simply select the file, and click ‘OK’ to reconnect the file to the project.

NOTE: This requires that you know where the file is!!!  If you can’t find the original media 
file you are in a mess of trouble.

                             Watch a 3:30 video on reconnecting media

•
If you have many ‘missing’ or 
‘disconnected’ files, select 
them all in your project panel.

Then, right click (control click) 
on one of them, and select 
‘Link Media’.

When you reconnect that one 
file, Premiere will automatically 
reconnect all the missing files 
in that folder.

If you have other folders, you 
will need to reconnect those 
files by repeating the steps 
above..

•

https://vimeo.com/187459249
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Color Correction

Ideally of course, you shot your video at the perfect exposure, with your white balance 
exactly right. Yes?

Hmmmm.....No? Your footage is underexposed? Your colors don’t look right?

Premiere allows us to correct some mistakes in our video - but NOT all mistakes are 
fixable.  It’s definitely true that you’ll get the best results by starting with the best original 
material - so remember to set your exposure and white balance before you shoot.

There are many, many, many, did I say many, ways to adjust your video.  I will show you 
some very basic techniques. 

Color Correction vs. Color Grading

Correction is about fixing mistakes and making the video look as natural as possible. 

Grading is about giving the overall video a particular look or feel. This tutorial only covers 
color correction.

Lumetri Color
The Lumetri Color panel makes basic color correction much easier than in the past.

•Place the playhead over the clip you want to fix, and double click.
•Select the “Color” tab from the dropdown button in the upper right to enter this color 
correction workspace.  Or, from the top menu bar, Window>Workspaces>Color
•Then click “Lumetri Scopes” in the source window.

•
With great power comes 
great responsibility.

Premiere is a very powerful 
video editor complete with 
many special effects, gadgets 
and super powers.

Just because you can make 
your video spherize, twirl, 
wave warp, and turbulent 
displace, doesn’t mean you 
should.

Edit with purpose. Avoid 
those special effects unless 
there is a compelling reason 
to use them.

•
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The Lumetri Scopes display shows information about the image - the amount of 
each primary color and the brightness. You can change the display by clicking on the 
small wrench at the bottom. This example shows the Parade display. It shows the 
amounts of the primary colors – red, green and blue.
The red is highest, showing the image has more red in it. A neutral image will have an 
equal balance of red, green and blue.

Other display options include Vectorscope, Waveform and Histogram. Each shows us 
something slightly different about the color and exposure. 

The Lumetri Panel lets you adjust color and brightness in multiple ways.  It can get 
pretty overwhelming.

Start with the basic panel.  Adjust your color first. Work your way down the list of 
tools as necessary.  

Watch the scopes on the left as well as the image. Try to remove any color cast.

From there, use exposure, contrast, highlights, etc. Again, use the scopes to make sure 
you’re not blocking up shadow detail or blowing out highlights.

IF a color hits the top of bottom of the scale, you’ve lost detail and have a pure black 
or white.

•
Color correction can 
be overwhelming. It is a 
profession in its own right.

For basic correction keep 
it simple. Aim to get colors 
looking natural and consistent.

So as you move from one 
clip to the next there isn’t an 
unnatural shift of color (unless 
you want one of course)

Using the Parade Display is a 
good place to start.

•

•
PASTE ATTRIBUTES
If a clip, or clips shot under 
the same light exist in multiple 
places on your timeline, you 
can correct one and then 
apply those settings to other 
clips. 

WAY easier than fixing each 
clip manually.

After fixing one clip, copy it.
⌘-C

Right-click on any other similar 
clip(s) and go
Edit>Paste Attributes
Click OK to apply the 
changes to all clips selected.

Note how the colors, especially the blue, hit the top of the graph - areas 
of the image are so overexposed as to have lost detail. This is generally 
not a good thing.  Work to expose and your video properly in the first 
place and then adjust with care.



Editing With Adobe Premiere Pro

Tips & Tricks

updated June 2022

27

You can select other displays by clicking 
on the small wrench tool. Each display 
shows you the color and brightness space 
in different ways. 

The waveform is similar to Parade

The vectorscopes show brightness and 
intensity.

You can have multiple displays open at 
the same time.

Waveform, Vectorscope and Parade all displayed in the Source Window. 
Note this is after adjusting the clip so the red green and blue nearly equal.
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•
There are so many ways 
to color correct and adjust 
your image. There are books 
on the subject and a million 
resources online.

YouTube is overflowing with 
free tutorials.
•
•
Beyond fixing an individual 
clip, think about the project as 
a whole.
Try to keep a consistent look. 
Look at what clip comes 
before or after the one you’re 
adjusting.

•

BEFORE:
Notice how the red 
spikes and blue is much 
smaller in the parade 
scope. 

AFTER:
The height of the colors 
in the Parade scope are 
more similar and the 
brightness of all three 
colors pushed up and 
spread out a bit.
Overall the color is more 
natural and vibrant.

Your monitor might not be adjusted properly, or your eyes may be fooled by the im-
age, the scopes don’t lie. Rely on them.

Note above how all the colors in the scope are well below the top, this indicates the 
image is underexposed, too dark. The blue is the highest. If you know your colors, you’ll 
know yellow is the opposite of blue. The blue is high, meaning there is not enough of 
yellow in the picture.

Also note how they are all shifted towards the bottom. There is a lot of room above 
each of the colors in the scope.  This indicates the picture is too dark.
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Other settings within the Lumetri Panel can give you more ways to con-
trol thelook of your clips.

The Creative Panel

You can select from preset looks in the dropdown 
menu - range of film simulations are available including 
B&W.

You can make custom adjustments using the sliders 
below.

The Curves Panel

You can adjust curves and saturation for the master 
clip or for individual color channels

You can adjust color and brightness to the shadows, 
midtones and highlights separately. 

Watch a 6:48 video on color correcting
in Premiere

You can toggle the effect or 
reset it directly in the Color 
Correction window

Fx will turn the effects on or 
off
The arrow will reset all 
your changes and let you 
start over

•

You can match or compare 
clips, or changes within a 
clip. Premiere even offers 
an AI based automode 
for matching clips, with an 
emphasis on  matching skin 
tones.

•

https://vimeo.com/187462271
https://vimeo.com/187462271
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Pasting Attributes

If you have multiple clips, shot under the same conditions, you don’t have to 
tone each one separately.

Tone one clip, then select it on the timeline and ‘copy’ it using ⌘-C or 
Edit>Copy.

Select any similar clips.

Right click, (or Control Click) and select ‘Paste Atrributes’
Check which attributes you want to paste - for color correction using Lumetri, 
select that box.

Click OK

This will apply the same corrections to any and all clips you have selected.

Watch a 1:42 video on 
pasting attributes

https://vimeo.com/187479562
https://vimeo.com/187479562
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Comparison View

Premiere now offers a few nice ways to match color or adjust color inside Comparison 
View.

You can use this feature in two ways.

1. If you’re working on a clip, you can see before and after, side by side, to see your 
adjustments.

2. If you want to match two clips so they have the same color, you can compare and 
either automatically or manually adjust one clip to match the other.

Go to Color Wheels and Match in the Lumetri Color panel and select “Comparison 
View” to use the new feature. 

1. Make sure you’re in the color panel (top row of buttons)                                            
 (If you don’t see the Lumetri Panel on the far right, go to Window>Lumetri Color)

2. Select the Color Wheels and Match tab

3. Click Comparison View to enter the comparison mode
4. To compare before and after of a single clip click the Shot or Frame Comparison 
button.
5. Use the ‘undo’ button in the top right to reset a clip if you don’t like the adustments 
you’ve made.
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If you have multiple clips shot under similar lighting conditions that you want to match, 
set the best looking clip as the Reference Frame by using the slider underneath the 
Reference Frame to find it on the timeline.

Then, place the playhead over the frame you want to match and click Apply Match. 
Premiere will do it’s best to match color and look. You can then manually further adjust 
the clip as needed.

The Reference clip is the clip that is correct. You will match to this clip. You can select it 
by dragging the slider below it through your sequence or by entering the time it appears 
in the sequence.

The Current clip is the one you want to fix by matching it to the Reference clip. In the 
timeline, simply slide the playhead over the clip you want to fix. 

Once the clips are selected, click Apply Match. If there are faces in the scene, leaving 
the Face Detection box checked will prioritize the faces in Premiere’s decision making 
process. 

Watch a 7:30 video on using the Comparison View features

•
According to Adobe, 
using Face Detection 
takes the program a bit 
longer to process.

If there are no faces 
in the scene they 
suggest turning off Face 
Detection to save time.

If you have faces, and 
don’t like the look with 
Face Detection on, try 
turning it off to see if it 
looks better.

•

https://vimeo.com/584558728
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Titles

Basic titles are created using the Text Tool, graphic elements can be added using the 
Rectangle tool. There are many pre-built templates available as well for titles and lower 
thirds in the graphic library.

It is not entirely intuitive, or doesn’t feel that way to me yet, but once you get the hang of 
it, adding titles is not very tricky.

Place the playhead in your timeline where you’d like to place your title. (you can always 
move it later.)

Select the Type Tool (T) and click on the video and begin typing.

After typing in your title, you can change fonts, size, color, etc in the edit tab of the 
Essential Graphics Pane.

In addition to type you can add shapes, lines, etc. Select the Pen Tool (P) and use the 
dropdown menu to select the rectangle tool for example, to put a box around your type.

•
Get in the habit of switching to 
the Selection Tool when you’re 
not typing text for a title.

If you stay on the Title Tool 
you’ll create a new empty 
Title with each click. Not a big 
problem, just annoying.

These can be deleted in the 
Effects Control Tab

•
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You can also create simple animation, fade in and outs, or change the size by using key-
frames.

Again, you can change characteristics of the shape in the Effects Control Tab.

COPY A TITLE SLIDE

If you want to copy a title slide, to keep a consistent look - simply hold down the option 
key as you cick and drag the title slide to the left or right. Instead of moving it, you create 
a copy.

Watch a 9:15 video on creating basic titles

Exporting

The last step is to export your video. Creating a playable movie file for all the world to 
see.

https://vimeo.com/187483906
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File>Export>Media... or  ⌘ M or select the Export tab
The export window is a bit complicated.  There are MANY options for exporting your 
video and the settings depend on what you need.

• Are you creating a high quality archive for your flies?
• Do you need to post to a specific site such as YouTube or Vimeo 
• Is it for broadcast on television or social media?
• Do you have a client with a specific need?

All of these will influence how you export your video.

Step one is deciding what to export. Do you want to export everything on the timeline, 
or just part of a project.

You can export the entire sequence or a just a portion. Designate a work area or use 
the In/Out settings to set the part of your timeline you’d like to export.

•
A common mistake when 
exporting is to forget about 
clips you’ve left at the end 
of a timeline. Maybe you 
dragged them there ‘just in 
case’. 

Those ‘orphaned’ clips will 
make your export time 
very long, and create much 
embarrassment when you 
play back your piece and 
odd clips appear after the 
show is supposed to end. 
Setting a work area or in 
and out points guarantees 
only what you want is 
exported

•
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Range: Entire Source will export everything on the timeline. If you don’t want that, 
you can set a specific area to export.

File Name: Name your file. A good rule is to always include your name in the file 
name.

Location: Select where to save the video file. If you createed an Output folder in 
your project folder, use that.

Format & Preset:  Establishes the file type for your exported movie. 
Generally, you’ll use h.264 for the format.
Under preset select ‘more presets’ and scroll to Vimeo 1080p Full HD. Click the star 
and it will be added to the list. This is a decent all around good setting for most videos 
, but select other settings if necessary for your particular needs.

You can if you wish upload directly to YouTube, Vimeo, Twitter, etc. from the list on the 
left.

Export: Click export and your video will start exporting immediately using Pre-
miere. This means you won’t be able to do anything else in Premiere until exporting is 
complete.

•
Export settings specific to the 
workflow in the classroom.

1.  FOR CLASS
 Use H.264 Select:
 Vimeo 1080HD

•

NOTE
If you export more than one 
version of a video, you MUST 
name them with distinct names.

ALWAYS put your name in the 
file name - so we know who 
created the video.

Smith_Circus_HiRes.mp4
Smith_Circus_Insta.mp4

Would be a good way to name 
a video by Smith, about a circus. 
One high resolution version and 
one version specically sized for 
Instagram, for example.
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Queue: will open Adobe Media Encoder, a separate program. You can load up multiple 
exports (for example, you want a highest quality version for yourself, and a lower 
quality version for YouTube). You can then start Media Encoder and continue working in 
Premiere.

When it’s finished exporting, watch it!!  
Make sure there are no mistakes including, but not limited to:

typos
dropped audio
gaps between clips
uneven audio
bad edits
bad color/toning
extra clips at the end
missing lower thirds
missing titles
missing credit
things you don’t like

Go back, fix them, re-export, and watch it again.

When it’s perfect, you’re done!!

Watch a 5:01 video on exporting

https://vimeo.com/187484676
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Sizing Video & Stills

Sometimes it is necessary to change the size of your video or photographs.

Remember that your timeline is set up for a particular size – usually 1920 pixels x 1080 
pixels.

If you import a high resolution still photo it will look cropped on the timeline and need to 
be resized.

You may also want to crop a video clip, or resize it for another reason.

There are multiple ways to crop or change the size of an image.v

In this example, I imported a photo, that is MUCH larger than the video. Placed on 
the timeline, it doesn’t fit. The high resolution image has many more pixels than the 
1920x1080 timeline.

Control or Right-Click on the clip on the timeline (NOT on the image itself)

Select “Set To Frame Size” from the drop down menu.

•
You may have noticed two 
similar options for resizing 
images:

Set To Frame Size
&

Scale To Frame Size

They both will resize the 
image to fit the sequence 
settings.

Scale to Frame Size resizes 
the image to 100% so it fits 
perfectly. This reduces the 
burden on your computer 
processor, BUT it means 
that if you want to crop the 
image to fit the screen or 
make other changes you’ll 
be resizing it above 100%.

Set to Frame Size leaves 
the image at it’s full resolu-
tion so you have the ability 
later to resize it. 

As a rule, I’d use Set To 
Frame Size
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Notice that the image is resized so that it fits the screen.

NOTE:  Photos are usually a different shape from video. So this photo doesn’t fit 
the video window and we can see the edges of the underlying video.

To fix this, you will want to enlarge the image slightly - covering the edges of the 
video window.

Double click on the image and drag out the blue box to finish sizing the image.
v

Watch a 4:05 video on cropping and resizing in Premiere

Bonus Tip!
You can set Premiere to 
automatically adjust all 
imported media to Set 
To Frame Size or Scale To 
Frame Size:
Preferences>Media>Default 
Media Scaling>set to frame 
size but note that files that 
are small will be upsized and 
might not look great on the 
screen. 

https://vimeo.com/187485342
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Transcribing and Captioning

Premiere offers transcribing and captioning

Many videographers and filmmakers transcribe their interviews. This allows them to edit 
to the edit the text on a screen. Some will even print it out and cut it up so they can 
experiment with rearranging the order of an interview.

Captioning can include closed captioning - the kind you can turn on and off on YouTube, 
Netflix, Hulu, etc. Or it can mean open captioning where the caption is burned into the 
video - something you see a lot on social media posts.  Premiere can do both, simply and 
easily.

• First, place your audio on the timeline.
• Then select the Captions tab at the top.

• Click the Transcribe sequence button

•
If you want to transcribe an 
interview, you would do that 
first thing before you began 
to edit.

If you want to create cap-
tions, wait until you are done 
editing your video.

•
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If you tagged your clips as dialogue, you can 
use that button.

But generally click the  “Audio on track” 
button and then select which track you 
want to analyze from the dropdown box. 

Select your language and choose the other 
options if you need to. Usually you can leave 
these unchecked.

Click “Transcribe.”  NOTE that part of the 
process is uploading the audio to the cloud 
for analysis. You will need to be online to 
make this all work.

The longer the audio, and the slower your 
internet connection, the longer it takes. 

Adobe generates this 
transcription window.

To export as text, click the the 
three dots in the upper right and 
select “Export to text file.”

If you play your audio notice 
that the blue highlighted text will 
follow along. 

You can double click on the text 
to make corrections or changes.

Click “Create Captions” to add a subtitle track to your video timeline.
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You can adjust these options as you see fit, but for the 
most part you’ll probably use the default settings. 

Create from sequence transcript means you want to 
use the transcript you just created.

Caption preset and Format should be Subtitle, unless 
you have a specific other purpose. 

If you haven’t set a style yet, leave it at None.

Click z and Premiere will process the transcription and 
add a track to your Timeline called “subtitle.”

You can still edit the captions by changing the text in the top left Source window. 

You can style the text by selecting one of the yellow subtitle clips and then 
change the look in the Essential Graphics panel on the right. Select the edit tab 
to get to the tools. 
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After adjusting the text to your liking, save the settings under the Track Style 
dropdown menu as a custom setting. you can then apply this style to the entire 
project. 

When you’re done you have a few options.

Leave the captions visible as open captions. These would be permanently ‘burned in 
to your video.  To do this, simply export your video as you would any video. 

Create closed captions for a service like YouTube where the viewer could toggle 
captions on or off.  To do this, ‘hide’ the subtitle track by clicking the ‘eye’ icon to 
make it invisible.

Then, export the subtitles as an SRT file using the dropdown menu. Upload 
this along with your video to a service like YouTube and your captions will be 
automatically processed. 

Watch this 10:05 video on using the Transcribing and Captioning features

https://support.google.com/youtube/answer/2734796?hl=en#zippy=%2Cupload-a-file
https://vimeo.com/585127889
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VR
360 VR Video

Premiere keeps adding support for 360 video.

You can view your video as a 360 inside of Premiere

You can export your video VR ready for YouTube, Facebook and other VR ready sites and 
applications.

You can adjust what is the ‘front facing’ view of your video,, drop in flat videos on top, etc. 

Change Starting Point
By default your 360 video will start with where the front of your camera was pointing. If 
you want to change that in Premiere, use the VR Projection Effect:

Effects>Immersive Video> VR Projection
Drag that filter onto the clip on your Timeline
Change the Pan to change the starting point
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If you have specific questions about this tutorial, or Premiere in general feel free 
to contact me.

If you’re a current student, I hope you know how already!!

Email is the best option:  Will.Yurman@gmail.com

There are a LOT of resources online for help as well.

- Will Yurman  

Exporting VR

VR 360 video requires specific metadata embedded in the video file. 

Luckily, Premiere will do that work for you. Make sure to select the 
Video is VR box when exporting.

Upload your video to YouTube, Vimeo, Facebook or other VR supported sites and it 
should be recognized automatically as a VR video.

Watch a 4:39 video on editing and exporting VR video in Premiere (based on an older 
version of Premiere. New features have been added)

•
If you want to watch 360 video 
on your computer, without 
uploading it and watching it 
through your browser, use the 
free GoPro VR Player app from 
GoPro

•

•
Penn State has some good 
tutorials for basic editing of 
360 VR footage.

•

mailto:mailto:Will.Yurman%40gmail.com?subject=
http://There are a LOT of resources online for help as well.  Lynda.com is a great resource (and free to Pe
http://Exporting VR
https://vimeo.com/218518155
https://gopro.com/en/us/news/gopro-vr-player-2-now-available
https://sites.psu.edu/interactive360video/editing/
https://sites.psu.edu/interactive360video/editing/

